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About These Instructions

These instructions describe how to operate your BD FACSCalibur™ flow 
cytometer using BD FACStation™ software. BD Biosciences recommends that 
first-time users take advantage of operator training offered with the sale of every 
new instrument.

The BD FACSCalibur Instructions for Use assumes you have a working 
knowledge of the Mac® OS X operating system.

Conventions

The following conventions are used in these instructions.

Table 1  Hazard symbolsa

a. Although these symbols appear in color on the instrument, they are in black and white throughout this user’s 
guide; their meaning remains unchanged.

Symbol Meaning

CAUTION: hazard or unsafe practice that could result in material damage, 
data loss, minor or severe injury, or death

Electrical danger

Laser radiation

Biological risk
xi



Table 2  Text and keyboard conventions

Convention Use

Tip     Highlights features or hints that can save time and prevent 
difficulties

Italics Italics are used to highlight book titles and new or unfamiliar 
terms on their first appearance in the text. 

> The arrow indicates a menu choice. For example, “choose 
File > Print” means to choose Print from the File menu.

Command-X Keyboard shortcuts use the Command key ( ) in 
combination with another indicated keystroke. For example, 
Command-K means to hold down the Command key while 
pressing the letter k.
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Introduction

The BD FACSCalibur flow cytometer identifies and enumerates lymphocyte 
subsets in human cells in suspension.
13



System Components and Theory of Operation

The BD FACSCalibur system consists of a flow cytometer and BD FACStation 
workstation (Figure 1-1). An optional, automated sample loader is also available.

Figure 1-1  BD FACSCalibur system with BD FACS Loader option
14 BD FACSCalibur Instructions for Use



Cytometer Components

Figure 1-2  BD FACSCalibur sensor unit

Fluidics Components and Theory of Operation

You install tubes onto the sample injection port (SIP). Samples are carried to the 
flow cell through a stainless steel sample injection tube (SIT) surrounded by a 
droplet containment sleeve. The sleeve works in conjunction with a vacuum 
pump to eliminate droplets as fluid backflows from the SIT. The vacuum pump is 
activated by the tube support arm—the vacuum is on when the arm is to the side 
and off when the arm is centered.

Figure 1-3  Sample injection port (SIP)

fluidics control panel
fluidics

sample injection port

power switch

drawer

sample injection tube

droplet containment sleeve

tube stop

tube support arm

(SIT)
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Buttons in the fluidics control panel are used to set the sample flow rate and fluid 
modes. 

Figure 1-4  Fluidics control panel

Approximate sample flow rate:

• LO: 12 µL ±3 µL/min

• MED: 35 µL ±5 µL/min

• HI: 60 µL ±7 µL/min

Fluid modes:

• RUN pressurizes the sample tube to transport sample through the SIT and 
into the flow cell. The button is green when a sample tube is installed, the 
tube support arm is centered, and the tube is pressurized. When the arm is 
to the side, the button turns orange and the instrument switches to standby.

• STNDBY (standby) stops sheath flow to conserve fluid and lowers the blue 
laser power to prolong laser life.

• PRIME removes bubbles from the flow cell primarily during 
troubleshooting. At completion, the instrument goes into standby mode.

LO MED HI

RUN STNDBY PRIME fluid mode

sample flow rate
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The fluidics drawer holds the sheath and waste reservoirs. Both reservoirs have 
level sensors that indicate fluid levels via BD CellQuest™ Pro software.

Figure 1-5  Fluidics Drawer

• The 4-L sheath reservoir is secured by a metal bracket, which prevents the 
reservoir from expanding while under pressure. It holds enough fluid for 
approximately 3 hours of operation. Fluid is filtered through the sheath 
filter before it reaches the flow cell.

• The 4-L waste reservoir collects fluid waste from the flow cell.
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waste tubing

waste air vent tubing

waste tanksheath tank

sheath filter

sheath tubing

air supply tubing

metal bracket
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Optics Components and Theory of Operation

The standard BD FACSCalibur system includes a 15-mW, 488-nm, argon-ion 
laser and detectors for three fluorescent parameters. The FL4 option provides a 
second 635-nm, red-diode laser and an additional detector. Laser light is focused 
onto the flow cell by a focusing lens. As fluorescently tagged particles intercept 
the laser light in the flow cell, scattered and fluorescent light provide information 
about particle size, shape, granularity, and fluorescence intensity.

Forward scatter (FSC) signal is collected by the FSC diode. Side scatter (SSC) and 
fluorescent signals are collected by a fluorescence collection lens and spectrally 
split by a collection of dichroic mirrors (DMs) and filters. See page 220 for 
wavelength characteristics of the dichroic mirrors and filters.

Figure 1-6  BD FACSCalibur optics system (standard)

SSC

FL1

FL2

FL3

488/10 530/30

90/10 beam splitter

DM 560SP

DM 640LP

585/42

650LP

FSC diode488/10

focusing lens

collection lens
fluorescence

488-nm 
blue laser

flow cell
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Figure 1-7  Optics system with FL4 option

SSC

FL1

FL2
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FL4

530/30
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half mirror

488/10
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beam
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Loader (Optional)

The BD FACS™ Loader option automates acquisition from tubes. It mounts 
directly on the flow cytometer. A cover fits over the drawer to protect you from 
moving parts.

Figure 1-8  Tube loader components

Carousel

The carousel rack accommodates up to forty 12 x 75-mm tubes. Each carousel 
has a unique ID printed on top and on an optically read label inside.

tube lifter

rack spindle

optical
sensors

drawer

alignment hole

spindle hole
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Keypad

The keypad communicates with the Loader via a SCSI cable. Use the keypad to 
turn the Loader on and off, and to operate it manually. (Keypad keys are disabled 
during a Worklist run.)

Each time the Loader is turned on and the cover is in place, the Loader performs 
an initialization scan. The LED display shows Loader status. After a successful 
scan, the status reads Tube 01.

Figure 1-9  Loader keypad

During manual operation, use keypad buttons for the following:

• RACK—moves carousel in the direction indicated

• LIFTER—raises or lowers a tube

• MIXING—vibrates the rack to mix sample tubes

- Press and release the button for a short (LOW) mix. When finished, the 
carousel returns to its original position.

- Press and hold the button for 2 seconds for a longer (HIGH) mix. 
When finished, the carousel always returns to position 1.

BECTON

DICKINSON

ON

OFF

MIXINGRACK LIFTER

UP

DOWN

HIGH

LOW

SCSI cable

LED display

Lifter button

Mixing button

Rack buttons

power button
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Power Controls

The power switch on the right side of the cytometer does not completely shut off 
instrument power. To shut off all power, use the switch in back of the instrument 
(Figure 1-10). If you are using a power transformer, use the main power switch 
on the transformer (Figure 1-11).

Figure 1-10  Instrument main power switch (115 VAC)

Figure 1-11  Transformer main power switch (230 VAC)

Main power switch

Connector for 
GPIO cable

Connector for optional 
BD FACS Loader cable
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System Requirements

Hardware

• BD FACStation Macintosh® computer purchased through BD Biosciences

• USB security module or dongle (for running BD CellQuest Pro software)

• (optional) BD FACS Loader for automated sample acquisition

Software

• Mac OS X - see the Read Before You Install file on the BD FACStation CD 
for specific version requirements.

• BD FACStation software version 6.0 or later (See Chapter 2 for an 
overview)

Tubes

• 12 x 75-mm polystyrene BD Falcon™ tubes

• 12 x 75-mm BD Trucount™ tubes

Bulk Fluids

• Sheath: BD FACSFlow™ solution

• Cleaning: BD FACS™ Clean or 10% household bleach

• Rinsing: BD FACS™ shutdown solution or deionized (DI) water

• Waste decontamination: full-strength bleach

Setup Beads

BD Calibrite™ beads 
Chapter 1: Introduction 23
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2

BD FACStation Software

The following come with the BD FACStation system:

The following can be purchased:

BDPAC software for installing required startup files or BD Inits

BD CellQuest Pro software for general data acquisition and analysis

BD FACSComp™ software for instrument calibration and quality 
control (instrument settings can also be generated using 
BD CellQuest Pro or BD Multiset™) 

BD™ Worklist Manager and Loader Manager software for 
operating and maintaining the optional BD FACS Loader

BD Multiset software for identifying lymphocytes and lymphocyte 
subsets in samples stained with BD Tritest™ and BD Multitest™ 
reagents, and for acquiring and analyzing samples stained with lyse/
wash or lyse/no-wash user-defined reagents (one- through four-color)

BD™ HLA-B27 software for determining HLA-B27 antigen 
expression
25



This figure shows the workflow for running samples with BD FACStation 
software:

Tip     To create a shortcut for launching applications, drag the software icon from 
the Finder window to the Dock. You can then launch the software by clicking its 
icon in the Dock.

The first time you launch each software application, enter your user name and 
institution in the Registration dialog:

start up perform shut down
QC

optimize
settings

acquire &
analyze data

BD CellQuest Pro icon
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BDPAC Software

BDPAC software installs required startup files, or BD Inits, needed for 
acquisition. Update BDPAC information:

• if you reinstall BD FACStation software

• if you connect your BD FACStation computer to a different cytometer

• if you upgrade your cytometer with new options

1 Quit BD CellQuest Pro software, if it is running.

2 Launch BDPAC software: 

3 Enter the cytometer serial number, and choose the cytometer type.

4 Select the checkboxes for your cytometer options, and click OK.
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BD CellQuest Pro Software

When you launch the software, a blank Experiment document window and the 
tool palette appear. Use tools in the palette to create or edit objects in the 
Experiment document window.

Selection tool—select, move, or resize items in the Experiment 
document window

To select an object, click its border: black 
handles appear. Only selected objects can be 
deleted, resized, moved, or formatted using 
the Inspector. (To select more than one 
object, press Shift as you select.) 

To make an object active, click inside its 
border: the object’s border turns blue. An 
active object is the target of any chosen 
commands. Only one object can be active at 
a time.

tool palette
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Plot tools—create contour (C), 3-dimensional (3D), density 
(D), histogram (H), or dot (d) plots

To create a plot, select a tool, click in the Experiment 
document window, and drag to set the plot size.

Marker tools—select a range of data on a histogram plot (H) 
or divide a dot, density, or contour plot into quadrants (Q)

Zoom tools—magnify an area of a plot (+) or return the plot to 
its original size (–)

Region tools—create rectangular (R), polygonal (P), elliptical 
(E), or Snap-To (S) regions on dot, density, or contour plots, or 
create histogram (H) regions on a histogram plot (histogram 
regions are used for gates; histogram markers are used for 
statistics)

Text tool—create or edit free text

Arrow tool—draw arrows, starting from an empty area of the 
Experiment document

Expression Editor tool—create mathematical expressions using 
statistical results

Calculator tool—recalculate data when Auto Recalculate 
(Gates menu) is turned off

C

3D

D

H

d

H Q

R

H

P

E

S
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BD CellQuest Pro Files

File Type Description Default Name

Experiment 
document

BD CellQuest Pro file containing any subset 
of user-defined plots, regions, gates, 
markers, statistics, tube lists in Browser, 
acquisition settings, calculated expressions, 
text annotations, or color preferences 
(documents can also be saved as PDFs by 
choosing File > Print, and clicking Save As 
PDF)

Untitledn (the software 
adds a number to each 
subsequent file)

Data file FCS 2.0a data file containing parameter 
measurements for each event in a sample, 
information about the sample, and 
cytometer instrument settings in effect when 
the sample was collected

a. Refer to: Data file standard for flow cytometry. Data File Standards Committee of the International Society for 
Analytical Cytology. Cytometry. 1990;11(3):323-332.

Data.nnn

Statistics file Tab-delimited text file containing any 
combination of histogram, region, gate, and 
quadrant statistics 

untitled stats

Instrument 
settings file

BD instrument settings file containing 
detectors/amps, compensation, and pulse 
processing (if applicable) settings, threshold 
parameter and value, and special setup 
values (if applicable)

InstrSettings
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BD FACSComp Software

Use BD FACSComp software to monitor instrument performance, and to 
automatically set up the instrument for two-, three-, and four-color* 
immunophenotyping of human cells. 

Figure 2-1  BD FACSComp application window

The icon bar shows where you are in the run—the icon for the current view is 
highlighted. Do the following at each view.

* FL4 option required for four-color setup.

Sign in as the operator.

Select assays to run, enter lot IDs, and specify file names and 
storage locations.

icon bar
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Observe PMT voltage adjustment and time-delay calibration, if 
APC beads are detected. Adjust voltages manually, if needed.

Observe compensation adjustments and adjust compensation 
manually, if needed.

Observe a Sensitivity Test for each parameter.

Observe HLA-B27 calibration, when the assay is selected.

View or print the status of samples run and files saved.

Check and adjust instrument settings, if necessary, using control 
samples.
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BD FACSComp Preferences

Use Optimization to change preset 
choices for an optimization option. 
The following can be changed:

• File Name: name of optimized file

• Instrument Settings Read: settings 
to download

• Plot X, Y Parameters: choose from 
drop-down menus

Use Export to specify delimiter types 
(Tab or Comma) for exported 
document files.

Use Printing to specify when to print 
Summary Reports: after each assay 
(automatic printing) or never (you 
print manually). You can also select to 
save electronic reports at the Set Up 
view and print them later.

Use Page Setup to set page size and 
orientation and Print Setup to set 
printer-specific options.

Use LJ Data to set the number of 
BD FACSComp runs to save in each 
Levey-Jennings file. The file is tab- or 
comma-delimited depending on your 
Export preference choice.

When the specified number of runs 
have been saved, new data will replace 
the oldest entries.
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BD FACSComp Files

For LW and LNW assays, BD FACSComp software creates a calibration (calib) 
file, Target file, and Target Value Log file. You can also choose to save a 
Summary Report file (at the Set Up view), a Levey-Jennings Database file (in 
preferences), and an Optimization file (at the Optimization view).

A calib file is created each time BD FACSComp runs to completion. Calib files 
are BD instrument settings files with a keyword for overall Sensitivity Test results 
(TRUE if all parameters pass; FALSE if any parameter fails). Only one version of 
each calib file can exist at a time. Each time a new assay is run, the new file 
overwrites the previous.

Tip     To set up for non-IVD applications, refer to the information provided by the 
manufacturer (reference manual or reagent package insert). 

Use Loader preferences to specify 
when you will be acquiring data with 
the Loader. When enabled, you can 
also select Walkaway Operation to 
run assays automatically, or 
Automatic Clean to run cleaning tubes 
when you quit the software.

Enable LeucoCOUNT to save a 
LeucoCOUNT calibration file at the 
successful completion of any LNW 
assay. The file is created from 
modified LNW or LNW PerCP-Cy5.5 
settings and is used to set up the 
cytometer when running 
BD Leucocount™–stained samples.
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File Type Description Default Name
Default Storage 
Location

LW Calib file Instrument settings file with 
results from LW assay

Use to set up cytometer for 
BD HLA-B27, BD 
Oncomark™, and 
BD CellQuest Pro LW 
applications.

Calib File BD Files > 
Instrument 
Settings Files

LW 
PerCP-Cy5.5 
Calib file

Instrument settings file with 
results from LW PerCP-Cy5.5 
assay

Use for LW applications using 
PerCP-Cy5.5 reagents.

Calib File. 
PerCP-Cy5.5

BD Files > 
Instrument 
Settings Files

LNW Calib 
file

Instrument settings file with 
results from LNW assay

Use for BD Multiset and 
BD CellQuest Pro LNW 
applications.

Calib File.LNW BD Files > 
Instrument 
Settings Files

LNW 
PerCP-Cy5.5 
Calib file

Instrument settings file with 
results from LNW 
PerCP-Cy5.5 assay

Use for LNW applications 
using PerCP-Cy5.5 reagents.

Calib File. 
LNWPerCP-Cy5.5

BD Files > 
Instrument 
Settings Files

HLA-B27 
Calib file 

Instrument settings file with 
results from HLA-B27 
calibration

Use with Calib File to set up 
for HLA-B27 assays.

Calib File.B27 BD Files > 
Instrument 
Settings Files

LeucoCOUNT 
Calib file 

Instrument settings file with 
results from LeucoCOUNT 
calibration (modified LNW 
settings file)

Use to set up for 
BD Leucocount assays.

LeucoCOUNT 
Calib File.LNW

BD Files > 
Instrument 
Settings Files
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Target files BD FACSComp file with target 
values for BD Calibrite beads. 
To edit, see page 65.

A Target file is also created for 
HLA-B27. Although used by 
BD FACSComp software, the 
file is not editable.

Target File, 
Target File.LNW

BD Applications 
> FACSComp 
Folder

Target value 
log files

BD FACSComp file with 
operator name, date, and up to 
100 sets of target values. 
Cannot be opened or viewed; 
only printed from within 
BD FACSComp software.

NOTICE     BD FACSComp 
software does not recognize a 
Target Value Log file from a 
previous version. When you 
upgrade, do not copy your 
previous Target Value Log file 
into the FACSComp folder.

Target Value Log 
File, Target Value 
Log File.LNW

BD Applications 
> FACSComp 
Folder

LW/LNW 
Summary 
Reports

Text (.sum) and graphic (.pdf) 
files containing analytical 
results of the run and the 
resulting instrument settings

Two files are produced for each 
of the LW and LNW assays.

DDMMYY.sum 
(.pdf), DDMMYY. 
PerCP-Cy5.5sum 
(.pdf), 
DDMMYY.LNW 
sum(.pdf), 
DDMMYY.LNW 
PerCP-Cy5.5sum 
(.pdf)

BD Files > 
FACSComp 
Files >dated 
folder from day 
assay was run

HLA-B27 
Summary 
Report

Text (.sum) and graphic (.pdf) 
files showing adjusted FL1 and 
SSC settings for HLA-B27 
testing

Two files are produced for each 
HLA-B27 calibration.

DDMMYY.B27 
sum, 
DDMMYY.B27 
sum.pdf

BD Files > 
FACSComp 
Files >dated 
folder from day 
assay was run

File Type Description Default Name
Default Storage 
Location
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Figure 2-2  Files in BD Applications > FACSComp folder

Levey Jennings 
(LJ) Data files

Text file with Summary Report 
data from 30 or 60 runs (set in 
LJ Data preferences). Set the 
delimiter type in Export 
preferences (page 33).

Open and analyze LJ Data files 
by third-party programs to 
monitor instrument 
performance over time.

LJ Data.LNW

LJ Data.LNW 
PerCP-Cy5.5

BD Applications 
> FACSComp 
Folder

Optimized instrument settings 
file

MultiTEST.opt, 
TriTEST.opt, 
Simultest.opt

BD Files > 
Instrument 
Settings Files

File Type Description Default Name
Default Storage 
Location

LJ data files

Target files
and logs
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Figure 2-3  Files in BD Files > FACSComp Files folder

dated report

daily summary

folder

calibration,
optimization

files

reports
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BD Multiset Software

Use BD Multiset software to identify lymphocytes and lymphocyte subsets in 
samples stained with BD Tritest and BD Multitest reagents, and to acquire and 
analyze samples stained with lyse/wash or lyse/no-wash user-defined reagents 
(1- through 4-color).

Figure 2-4  BD Multiset application window

The icon bar shows where you are in the run—the icon for the current view is 
highlighted. Do the following at each view.

Sign in as the operator.

Define run-specific information.

Launch and run BD FACSComp software.

icon bar
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Choose how to report results and which information 
will appear on reports.

Enter sample-specific information.

Observe data collection in dot plots.

View automatic analysis while in process.

View or print results for individual sample tubes.

View or print averaged results for a sample and reference 
range values.

View or print the status of all samples run and files 
saved.
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BD Multiset Preferences

Use Export to specify delimiter types 
(Tab or Comma) for exported document 
files.

Click Select Values to Export to choose 
the values you want included in the 
export document.

Use Printing to specify when to print 
reports: After Each Entry or After All 
Entries (automatic printing) or Never 
(you print manually). You can also select 
to save electronic reports at the Set Up 
view and print them later.

Deselect the Show Attractors checkbox 
to hide Attractors on Lab Reports; select 
the Display Percent Results As Real 
Numbers checkbox if you want 
percentages shown as real numbers on 
Summary Reports.

Click Page Setup to set page size and 
orientation and Print Setup to set printer-
specific options.

When the Data Source is From 
Cytometer, use Panels to choose a default 
panel (Run Fixed Panel) that will appear 
at the Samples view for all samples in the 
run.
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Use Events to customize acquisition 
stopping criteria, such as the maximum 
number of events or maximum 
acquisition time.

Use LJ MSET Data to set the number of 
BD Multiset runs to save in each Levey-
Jennings file. The file is tab- or comma-
delimited depending on your Export 
preference choice.

When the specified number of runs have 
been saved, new data will replace the 
oldest entries.

Use Columns to display and name up to 
3 custom columns in the Samples view.

Column information is shown at the Lab 
Report and Phys Report views, is stored 
in data files, and can be included in 
exported documents.

Use Banner to add a custom banner to 
the top of reports (eg, your institution’s 
name or logo).
42 BD FACSCalibur Instructions for Use



BD Multiset Tools

Access the following from the Tools menu.

Use Comments to define or edit up to 20 
comments (Edit Comments), and include 
a saved comment on Physician Reports.

Alternatively, select to hide the comments 
section entirely (Delete Comments 
Section For Physician Report).

Use Subset Ranges to define up to 
6 user-defined reference ranges 
for each subset, in absolute 
counts, percentages, or ratios.

Use Panel Tools to create custom 
reagent panels. 

Nine predefined control panels 
and 4 non-control panels are 
provided. Use control panels to 
run BD Trucount Low, Medium, 
and High Control beads. You 
cannot create additional control 
panels.
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Use Reagent Tools to customize 
Dot Plot Info (number and types 
of plots associated with each 
reagent), Acquisition Target Info 
(minimum number of events to 
acquire), and FL Parameter Info 
(antigen or fluorochrome for each 
parameter) for BD-defined 
reagents.

Click Revert to BD Defaults... to 
restore the original values. 
Default values are the BD-
preferred values.

Use Reagent Tools to define 
custom reagents by:

• Copying a BD-defined reagent 
and customizing FL Parameter 
Info, Acquisition Target Info, 
Population Colors/Names, Edit 
Subset Results, and Dot Plot 
Info.

• Customizing one of 15 
provided Attractor Templates 
(BD Applications > MultiSET 
folder > Templates Reagents 
folder).

• Customizing an Attractor Set 
created in BD Attractors™ 
software.

Use Lot IDs to enter lot 
information for reagents, 
controls, and BD Trucount beads.

Lot information is found in or on 
the product packaging; enter it 
manually or use a barcode 
scanner. 

BD reagent

user-defined reagent
44 BD FACSCalibur Instructions for Use



BD Multiset Files

BD Multiset software creates the following file types. 

File Type Description Default Name
Default Storage 
Location

Schedule 
document

BD Multiset file containing 
entries from Sign In, Set Up, 
Test Prefs, and Samples views 
and preferences. Entries in 
Subset Ranges, Panel Tools, 
Reagent Tools, and Lot IDs are 
not saved.a

DDMMYY.sch BD Applications 
> MultiSET 
Folder

Lab Report PDF file containing individual 
tube results from one sample 
with dot plots you choose to 
include

prefixnn.lab or 
nnprefix.labb

BD Files > 
MultiSET Files 
> dated folder 
from day assay 
was run

Physician 
Report

PDF file containing panel 
results from one sample

prefixnn.phy or 
nnprefix.phyb

BD Files > 
MultiSET Files 
> dated folder 
from day assay 
was run

Summary 
Report

PDF file listing all samples in 
the Samples view

One Summary Report is saved 
per Schedule document. 

ScheduleDocument
Name.sum

BD Files > 
MultiSET Files 
> dated folder 
from day assay 
was run

Data file FCS 2.0c data file containing 
data for one tube (reagent) of a 
sample, and cytometer 
instrument settings in effect 
when the sample was collected

prefixnn.tube 
number or 
nnprefix.tube 
numberb

BD Files > 
MultiSET Files 
> dated folder 
from day assay 
was run
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Export 
document

Text file containing sample and 
reagent information, and subset 
results for each tube

Export documents can contain 
data from samples (.exp) or 
controls (.cxp). The delimiter is 
set in Export Preferences.

DDMMYY.exp

DDMMYY.cxp

BD Files > 
MultiSET Files 
> dated folder 
from day assay 
was run

Levey-
Jennings (LJ) 
data file

Text file with control bead data 
from 30 or 60 runs (set in LJ 
Data preferences). Set the 
delimiter type in Export 
preferences (page 41).

Open and analyze LJ Data files 
by third-party programs to 
monitor instrument 
performance over time.

LJ MSET Data BD Files > 
MultiSET Files

a. NOTICE: When you open a Schedule document, verify that Subset Ranges, Panel Tools, Reagent Tools, and 
Lot IDs are correct before you acquire samples. Schedule documents include the latest entries for these settings.

b. Prefix specified in Set Up view, nn = entry number at Samples view. Order set in Set Up view.
c. Refer to: Data file standard for flow cytometry. Data File Standards Committee of the International Society for 

Analytical Cytology. Cytometry. 1990;11(3):323–332.

File Type Description Default Name
Default Storage 
Location
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BD HLA-B27 Software

Use BD HLA-B27 software to classify a sample as BD HLA-B27 negative or 
positive. This classification is based on the measured mean fluorescence intensity 
(MFI) compared to a predetermined decision-marker setting encoded in the suffix 
of the reagent antibody lot number.

Figure 2-5  BD HLA-B27 application window

The icon bar shows where you are in the run—the icon for the current view is 
highlighted. Do the following at each view.

Sign in as the operator.

Define run-specific information.
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Launch and run BD FACSComp software.

Enter sample-specific information.

Observe data collection in dot plots.

View automatic analysis while in process.

View or print results for individual sample tubes.

View or print the status of all samples run and files 
saved.
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BD HLA-B27 Preferences

Use Export to specify delimiter types (Tab 
or Comma) for exported document files.

Click Select Values to Export to select the 
values you want included in the exported 
file.

Use Printing to specify when to print 
reports: After Each Entry or After All 
Entries (automatic printing) or Never (you 
print manually). You can also select to 
save electronic reports at the Set Up view 
and print them later.

Use Page Setup to set page size and 
orientation and Print Setup to set printer-
specific options.

Use Scaling to set default scaling for the 
histogram in the Lab Report.

Use Columns to display and name up to 3 
custom columns in the Samples view.

Column information is shown at the Lab 
Report and Summary views, is stored in 
data files, and can be included in exported 
documents.
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